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Application sequencing is the process that takes an off-the-shelf Windows application and prepares it for streaming. This 
process consists of arranging the application in such a way that the portions of executable code needed first by the end user 
are put at the beginning of the sequenced file so they are the first to be sent over the network. This includes component files, 
DLLs and Registry settings. It is important to note that the application is not changed in any way.
Sequencing allows applications to run without installing or altering the host operating system. Application virtualization 
eliminates the need to test one application against all the others in a production environment for system conflicts, significantly 
reducing the time it takes to integrate applications. By creating virtualized application packages, they are turned into on-
demand services that are centrally administered from single management console.
Virtualized applications can be deployed in real-time and when users need them, instead of having to be installed manually. 
Users with laptops can even retain these services in a disconnected mode for a predefined amount of time which is normally 
45 days if not set by administrator.

Prerequisites
It is assumed that the readers has the basic knowledge of following technologies.

• Creating Virtual Machines using any of the following OS Virtualization technologies VirtualBox, VMWare 
Workstation, VMWare Server, Virtual PC or QEMU, etc

• Installing and patching Windows XP / Vista
• Installing softwares and MSI Technology
• Wise Package Studio, ORCA or any other re-packaging tool

Sequencing
Sequencing is the process of virtualizing one or more applications using Microsoft Application Virtualization process. The task 
of sequencing can be divided into following sections:

• Naming Conventions
• Source Files Validation
• Virtual Machine Setup & App-V Client Installation and Configuration
• Application Installation & Configuration
• Shortcuts Configuration 
• Sequence Cleanup
• App-V Sequence Testing

In chapters to follow we will discuss all the sub-processes in details. 
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One of the most important task while creating any package is to validate the source files and sequencing process is no 
exception.
It is most important to understand that all applications can not be sequenced and not all applications which can be 
sequenced should be sequenced. Packager should make the judgment on which applications to sequence. Following list 
may help in making that decision.

Pre Installation Validation
Selecting an application for sequencing can be tricky task and following tips can be used to make that choice easier.

1. Device Driver: Microsoft Application Virtualization does not support sequencing of device drivers thus any 
application which install device driver should not be sequenced

The application can be sequenced only if the device driver can be installed locally without installing the 
application. In this case the device driver should be installed locally on the client machines and then the 
application without the device driver should be sequenced. Device driver then becomes a pre-requisite for 
the sequence to work on client machines

2. Application Size: If the maximum client cache size is set for 2 GB (The max can be 64 GB), then the maximum 
size of application (sft file) which can be streamed on that machine is 2 GB. All applications which have the installed 
footprint greater then or equal to the max client size, set by the client, should not be sequenced. Also the Max 
application size App-V can handle is 4GB, [Q: drive has FAT file type and the max file size FAT can handle is 
4GB ]. This issue is discussed in more details at http://www.softgridguru.com/viewtopic.php?t=2763

3. Shortcuts: Application should have minimum of one shortcut. If no shortcuts are present then the application should 
be sequenced in a suite along with the application which needs it. For example if Macromedia Flash is the 
application in question to be sequenced then the shortcut should be pointing to the locally installed Internet Explorer

4. Middleware: Middleware applications are not a good candidate for sequencing as they can be used as a 
prerequisite by multiple applications, thus should be installed locally. but if multiple version of it are needed then 
they should be sequenced along with the application which needs them. It is always advised to have only one 
version of any application/middleware in the organization thus conditions for multiple versions should be avoided
With Version 4.5 most of the middle-wares can be sequenced and used as secondary packages. See DCS Section 
for more details

5. Path hard coding: The application should not have folder/file path hard coding in the application itself. Some 
application hard code the path of files in registry or ini file or executable. In these cases it has been found that they 
can be sequenced most of the time using VFS sequencing method, but extreme care should be taken while 
sequencing & testing these applications. Also Configuration files such as ini, conf, txt, registries etc are good places 
to look for the hard coding

6. Base Build Applications: Applications which are already part of base build should not be sequenced. One can 
sequence them but they are of no real value as they will already be present on the client machines

7. Auto Update: Application with automatic updates should not be sequenced. Sequenced application most of the time 
fails to properly update itself. Also allowing auto update leads to non compliance of application version. These types 
of applications should only be sequenced if the auto update feature can be disabled during sequencing procedure

8. Services: Services which can be started when application starts and shuts down when application main executable 
shuts down can be included in sequence. Services that run as their own (like boot-time services do but there are 
others also) are  not suitable for sequencing since under App-V all application starting happens under user’s 
session context. Special thanks to ksaunam.
Also applications which installs services which run using specific user credentials can not be sequenced

9. COM+: Some application which uses COM+ might not work properly in virtual environment, thus this type of 
applications needs be tested properly

10. COM DLL: Few application which uses COM DLL surrogate virtualization, i.e. DLL’s that run in Dllhost.exe, does not 
work properly in App-V Environment. Thus this type of applications needs be tested properly

11. Licensing Policies: Applications with licensing enforcement tied to machine, e.g. the license is tied to the system’s 
MAC address, username etc. It should not be sequenced if activation cannot be done by the user at the first launch 
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of sequenced application
12. Internet Explorer & Service Packs: Internet Explorer, Windows service patches and service packs cannot & 

should not be sequenced
13. Network Share Application: It is not a good practice the run applications from network share as they tends to 

violate the enterprise desktop integrity and thus known to cause integration issues. It is advised to have to entire 
application inside of App-V package

14. Hosts file located in “%windir%\system32\etc” can not be sequenced and should be updated on local machine 
before the sequenced application is launched

Testing Source Files
Source files should always be tested before actual sequencing for two reasons

• To validate the source files installation and test cases

• To get all the requirements for the installation

Validating the Source files
It always saves time to test the installation of source files on a clean base machine and verify all the test cases without any 
version of app-v sequencer installed before starting the sequencing.

Requirements of Application
It is very important to accurately collect all the requirements as even one miss might lead to failure in production 
environment. It is always advised to make a list of all the dependent applications, middle-ware, custom setting required by 
main application. Evaluate all of them with regards to sequencing, that it makes sense to sequence them or install them 
locally
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Creating sequencing machine is also a very important task which should not be taken lightly and extreme care should be 
taken to maintain it.  The best policy of creating the sequencing machine is that it should have minimum common 
denominator softwares which means the applications which are present on every machines sequenced application where it 
will be streamed to.

Preparing Sequencing Machine
Operating System virtualization is the best way to create sequencing machines. Any of the following OS Virtualization product 
can be used: 

S.No Virtualization Technology License/cost Host OS Speed

1 QEMU Free & Open source Any Decent with plugins

2 RedHat XEN Free & Open source Linux Good

3 SUN VirtualBox Free & Open source Any Good

4 Microsoft Virtual PC Free Microsoft WinXP or latter Good

5 Vmware Server Free Any Good

6 VMWare Workstation Not Free & Costly Any Good

If virtual machine are not desired then a physical machine can also be used for sequencing. 
Sequencing machine (physical or virtual) should have at least the following requirements for normal packaging experience.

Hardware Requirements

1 C Drive 10 GB

2 Q Drive 10 GB

3 RAM 1 – 2 GB

Software Requirements

1 Operating System Win'XP Pro or Vista 

2 Service Pack Latest or the latest installed on client machines

3 VC Runtime 2005

The above requirements are for sequencing generic applications only and it may change depending upon the 
application to be sequenced in question

Installing App-V Sequencer
Installing App-V Sequencer is a very simple process. Only two per-requisites are needed for installing it:

1 . VC++ 2005 Runtime

2. Error Reporting 
Both of them can automatically installed when setup.exe file is used to install the sequencer. Following command can also be 
used to silently install the sequencer. 

setup.exe /s /v/qn+
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It is always advised to create a custom default.sprj file and copy it after the installation is completed.

Configuring App-V Sequencer
Few items should be customized before any sequencing can be started. It is also the best time to add exclusion items such 
as file, folder and registry key. Also the scratch folder location can be set at this time.

Adding Exclusion item
Defining exclusion items during repacking process is very important task and extreme care should be taken while defining 
them. There will be situations where one has to remove even the default exclusion items. One such case can be sequencing 
Google Chrome which gets installed in “%appdata%\Chromium\Application\” and %appdata% is added in default exclusion 
list, thus It always helps to know the application in advance and where the files gets copied.

The multiple default.sprj files are the best way to deal with various customization based on the application to be 
sequenced in question. You can create one default.sprj file with no exclusion item and one with maximum possible 
exclusion etc.

Custom Default.sprj
All the custom exclusions can be added to default.sprj which is stored along with the Sequencer. The custom exclusion 
list can be created either using any text editor or using the Sequencer itself and I would recommend using the 
Sequencer to create the custom default.sprj.
Before we can update the default.sprj file it needs to be created by using the following method.

Creating Default.sprj
When Microsoft App-V Sequencer is install then default.sprj file is created and it should be created using the 
sequencer.

1 . Launch the Sequencer and go to “Tools”→“Options” and Select “Exclusion Items” and select “Set as 
Default”

2. Select “Yes” and the default.sprj file is created in installed folder.
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Using Text Editor
1 . Open “C:\Program Files\Microsoft Application Virtualization Sequencer” in Windows Explorer
2. Open default.sprj file using your favorite Text Editor. Notepad++ is my favorite text editor which can be obtained 

from http://notepad-plus.sourceforge.net website.
3. Traverse to the end where “EXCLUSION” tags are present.
4. Create a new “EXCLUSION” tag and enter the values based on the following tables.

Exclusion Context Value

S.No Type Context Value Meaning

1 File VFS_EXC Map to File

2 File/Registry VFS_BOTH Map to both Registry and File

3 Registry VFR_EXC Map to registry

Exclusion Type Value

S.No Type Value Meaning

1 PSR_DataSystem

3. Save the file and use it.

Using App-V Sequencer
1 . Launch the Sequencer and go to “Tools”→“Options” and click on New

2. Select “New” and the default.sprj file is created in installed folder.
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Now that all the boring stuff is behind us, we can start the actual fun. Sequencing process ca

Types of Sequencing
There are two ways to sequence an application, MNT and VFS Sequencing. They both have some benefits and drawbacks 
and should be chosen based on your application.

MNT Sequencing or Q: Drive Sequencing
In MNT type, application is installed in Q Drive (mount drive) under mount point folder instead of installing it in its 
default location. Q Drive is the recommended sequencing method and should be used in all cases except DSC Installation 
and few other cases.

Benefits
• Sequenced application runs faster then VFS Sequenced application
• There are more changes of locally and sequenced application to coexist without any issue.

Drawbacks
• If application install location is hard coded then Q Drive sequencing can not be used

VFS Sequencing
In VFS sequencing the application and its supporting applications are installed in there default location. VFS sequencing is 
recommended process for sequencing DSC Sequencing.

Benefits
• Applications with hard-coded path entries can only be sequenced using this method.

• This is the best solution for sequencing DSC based applications which copy files in sub-folder of base applications.

Drawbacks
• Sequenced applications run slightly slower then Q Drive based sequence

• Some applications might not work properly, specially apps which try to evaluate the launch location at the launch 
time.

Sequencing
1. Start the sequencing machine.
2. Stop all the unwanted services such as

• Windows Update
• Help and Support
• Indexing Service
• Messenger
• Themes
• Anti Virus, anti spyware, firewall, etc 

Check with your computer security team before disabling any on these. Any one of them should not be 
disabled until you are sure that these are causing an issue in sequencing the application.

2009 © Mayank Johri Microsoft Application Virtualization - An Introduction to Sequencing



Sequencing 19

3. Launch all the applications which are already installed on the machine at least thrice, such as Office, winzip, etc
4. Create  a dummy ODBC entry, check appendix for details
5. Create a dummy printer, check appendix for details
6. Create a folder in Q: drive with name which represent [Package Request 

Sequence ID].[Revision]: - This folder should be in MSDOS compatible 8.3 format. 
e.g. 000000212.003 and RCAT3002.002.} This folder name should be always 
unique

The folder name can be generated using  “Maya Mount Point Generator” 
which can be downloaded from <XXXXX>. Always read the usage 
instruction before using it. If more then one person sequence the 
applications then install it on a network share and periodically take the 
backup of the database file

The reason it is needed in 8.3 formats is that all the packages are cached in Q: drive on the client machine and 
thus there is a change that two folder names will be same upto 6 characters and thus the sequencer client will 
not be able to identify them properly

7. Install the sequencer as described in previous chapter
8. Open the source files location in explorer and if possible copy all the source files in “%temp%\src” folder.
9. Start the Sequencer and select the “File” -> “New Package”

Configuration Wizard
Configuration wizard is used to define Sequence name, Mount Point Folder, install & configure the application.
10. In the package Information Window (Step 1) fill the following information

• Package Name: Enter the Package Name

• Comments: Many information can be entered such as sequencing date, sequencer name, packaging details such 
as source locations, packager name, packaging type etc

Installation Wizard
The Installation wizard is used to install and configure the application(s) 
11. Select the Mount Point Folder
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12. Start the installation of the application once the App-V Sequencer is minimized.

13. At least start the application three times and close it so that the application should reach in stable status.  For VFS 
Sequencing application should be installed at C:\Program Files\<app folder>, or its default directory where as in Q: Drive 
Sequencing the application should be installed in a subfolder under mount point folder.

 The reboot request is always captured by App-V sequencer thus if after the installation or during the installation 
a reboot is required then just stop and restart the monitoring. 

14. Once the installation and configuration is completed, press “Stop Monitoring”.
15. If any files needs to be added to the sequence then “Sequencing Wizard: Step 4 of 7” is the last chance to 

add the files.

Shortcut Wizard
In this section shortcuts & Feature Blocks are configured and on the “Configure Applications” Dialog followings items can be 
added:

• Add, Remove & Update Shortcuts
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• Add, Remove & Update File Type Association
• Add, Remove & Update Shortcut Display Location 

16. Remove all the unwanted shortcuts from the list such as readme.txt, help files, etc.

17. Set the appropriate version number in the Version section of shortcuts

18. Change all the shortcuts according to the following way
• If the package is installed in VFS mode then Change all the C:\Program Files to 

Q:\<MountPointFolder>\VFS\CSIDL_PROGRAM_FILES
• Version should not have any characters
• The OSD File should be like ShortcutName_Version_revision.osd, where ShortcutName will not have any spaces 

and version will have only digits and no special characters

 OSD Helper can be used to update the following automatically, It has a command line utility 

19. Select Next at the launch shortcut wizard
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Sequence Cleanup
Once the sequence has been created 
20. Remove any logged in user/computer specific information from Virtual Registry Section

21. In the Deployment tab update the followings:
• Protocol
• HostName
• Path
• Operating Systems: Add all Operating Systems in selected section

22. Save the package by selecting “File”->”Save” and select the folder as C:\temp\<SuiteName> as location and 
name as <SuiteName>

23. Copy the saved folder on the content share folder
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Once the sequence is created and copied to the content share, it needs to be published and tested before it can be published 
in production environment.

Publishing Application
In order to distribute the sequence to users, it needs to be published on a App-V Server. Applications can be published using 
Microsoft Application Virtualization Management System (MAVMS)

Installing Microsoft App-V Management Console (MAMC)
MAMC is installed by default on the App-V server and it can be installed as alone application on any machine with WinXP or 
above.

Prerequisites
F o l l o w i n g s  c o m p o n e n t s  n e e d s  t o  b e  i n s t a l l e d  

• M M C  3.0

• F r a m e w o r k . N E T  2.0

Installation
• L a u n c h  t h e  s e t u p . e x e  o f  S e r v e r  I n s t a l l a t i o n

•

Publishing
1 . Start the App-V Management console and select Applications and then the group where you want to publish the 

applicaition.
2. Right click and then select “New Application Group”

3. Enter the sequence name in the provided field

4. Right click on the newly created Application Group and select “Import Applications...”.
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5. Traverse and select the appropriate SPRJ or OSD File.

6. In the “Import Applications”, Select Enable, select appropriate License Group and Server Group.
7. Enter the location where the shortcuts should be displayed on the client machines, Default location is under “Publish 

to User’s Start Menu” and press Next
8. If the suite requires any file association then add the file association and press next
9. Select the appropriate groups and select Next and then Select Next and then Select “Finish”

Testing
Testing sequenced application should include the followings:

• Streaming on a fresh machine
• Launching and completing the test cases for admin and non-admin users.
• Validating the proper working of all the launch scripts if present.
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• Validating the OSD & SPRJ files for the followings Tags
• WorkingDir: It should not be empty
•

The Sequencer can test the application using either one the following methods:
• App-V Server: Publish the sequence and then test the sequence
• SoftGrid Package Manager (http://sourceforge.net/project/showfiles.php?group_id=210688)

App-V Server
A p p-V  S e r v e r  c a n  b e  u s e d  t o  s t r e a m  t h e  a p p l i c a t i o n  f o r  t e s t i n g  t h e  a p p l i c a t i o n . 
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Naming Convention
N a m i n g  a n y  p a c k a g e  i s  a  v e r y  v e r y  v e r y  s e r i o u s  b u s i n e s s  b u t  u s u a l l y  i t s  n o t  g i v e n  e n o u g h  t i m e  &  t h o u g h t . T h e r e  
i s  n o  h a r d  &  f a s t  r u l e  f o r  i t a n d  o n e  t h i n g  w h i c h  m a k e s  s e n s e  f o r  o n e  c a n ' t  m a k e  s e n s e  f o r  a n o t h e r. I h a v e  t r i e d  t o  
m a k e  f e w  s u g g e s t i o n s  b a s e d  o n  m y  e x p e r i e n c e  i n  v a r i o u s  f o r m s  o f  p a c k a g i n g . F e e l  f r e e  t o  e m a i l  a b o u t  y o u r  
c o m m e n t s  r e g a r d i n g  t h e m .

I t i s  a l w a y s  a d v i s e d  t o  h a v e  c o n s i s t e n t  n a m i n g  c o n v e n t i o n  f o r  b o t h  s u i t e  n a m e  a n d  O S D  f i l e s . A n d  i n  t h i s  c h a p t e r  
w e  w i l l  d i s c u s s  v a r i o u s  a s p e c t s  o f  i t.

W h i l e  c r e a t i n g  t h e  n a m i n g  c o n v e n t i o n  i t i s  a d v i s e d  t o  c r e a t e  a  m e c h a n i s m  t h a t  w i l l  e n s u r e  t h a t  n e v e r  w i l l 
t h e i r  b e  a  c h a n c e  f o r  m o r e  t h a n  o n e  i t e m  h a v e  t h e  s a m e  r e s u l t a n t  n a m e

Generic Guideline for Naming Convention
1 . N a m e  s h o u l d  b e  s i m p l e  

2. R e s u l t i n g  N a m e s  s h o u l d  b e  c o n s i s t e n t  &  u n i q u e

3. I n f o r m a t i o n  t h e y  c o n v e y  s h o u l d  s t a y  r e l e v a n t  w i t h  t i m e

4. E f f o r t s  s h o u l d  b e  m a d e  t o  k e e p  t h e  n a m e  s m a l l  s u c h  a s  u s i n g  a b b r e v i a t i o n s  f o r  V e n d o r  a n d  s u c h .

5 . T h e r e  s h o u l d  n o t  b e  t w o  a b b r e v i a t i o n s  f o r  t h e  s a m e  i t e m

6. I t e m s  w h i c h  m i g h t  n o t  b e  r e l e v a n t  i n  f u t u r e  s h o u l d  b e  a v o i d i n g  i n  t h e  n a m e ,  

◦ A d d i n g  O S  V a l u e  i n  t h e  n a m e  i s  n o t  a  g o o d  i d e a  a s  i n  f u t u r e  t h e  s a m e  p a c k a g e  m i g h t  w o r k  o n  
u p c o m i n g  O p e r a t i n g  S y s t e m

◦ A d d i n g  T a r g e t  B u s i n e s s  u n i t s  n a m e  i s  a l s o  n o t  a  g o o d  i d e a  a s  t h e  s a m e  p a c k a g e  m i g h t  b e  u s e d  b y  
a n o t h e r  b u s i n e s s  u n i t  i n  f u t u r e

7.  

Naming Convention in App-V
F o l l o w i n g  i t e m s  n e e d s  t o  b e  n a m e d  i n  A p p-V  c o n t e x t . 

1 . S e q u e n c e

2. O S D  F i l e

3 . D o m a i n  G r o u p  

Sequence Name
The Sequence name should be unique and cannot be used for more then one product version. It should also not exceed 
length of 64 characters. 
I would recommend the followings naming convention for Sequence names

<product>_<vendor>_<version>
where 
Product: Is the name of the product without spaces such as: Office, openOffice, Java 
Vendor: It should be an predefined abbreviations of the Vendor Name suchas: MS for Microsoft, SUN: for Sun Microsystems, 
INT for Intel etc.
Version: Version for the product, 11.0.66.123 etc. 

 In the product it is best to avoid the Version suchas: Office2003 is a bad example for Product. Also in Version 
2003 is a bad idea as many versions of Office 2003 are present. It is always advised to use the MSI Version if 
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the common product version and actual version name is different.

OSD File Name
O S D  F i l e  n a m e  & V e r s i o n  c o m b i n a t i o n  s h o u l d  b e  u n i q u e  i n  t h e  A p p-V  i n f r a s t r u c t u r e  a n d  a t  n o  p o i n t  t w o  O S D  f i l e s  
c a n  h a v e  s a m e  N a m e  &  V e r s i o n  c o m b i n a t i o n . 

T h e  b e s t  w a y  t o  o b t a i n  t h a t  i s  t o  r e m o v e  a l l  t h e  s h o r t c u t s  w h i c h  h a v e  v e r y  c o m m o n  n a m e s  s u c h  a s  R E A D M E ,  
R e a d m e . l s t  e t c . I f t h e s e  f i l e s  a r e  n o t  i m p o r t a n t  t h e n  r e m o v e  t h e m  f r o m  t h e  p a c k a g e  i t s e l f  o r  e l s e  a d d  a p p n a m e  i n  
t h e  b e g i n n i n g  o f  t h e  O S D  f i l e  n a m e .

I w o u l d  r e c o m m e n d  t h e  f o l l o w i n g  n a m i n g  c o n v e n t i o n  f o r  O S D  f i l e s

<ShortcutName>_<Version>.osd 

w h e r e  

<ShortcutName> i s  s h o r t c u t  n a m e   w i t h o u t  s p a c e s  a n d  

<Version> i s  t h e  v e r s i o n  o f  t h e  p r o d u c t  (an d  n o t  o f  t h e  a p p l i c a t i o n  t o  w h i c h  t h e  s h o r t c u t  i s  p o i n t i n g).

2009 © Mayank Johri Microsoft Application Virtualization - An Introduction to Sequencing


	Introduction
	Prerequisites
	Sequencing

	Source Files Validation
	Pre Installation Validation
	Testing Source Files
	Validating the Source files
	Requirements of Application


	Pre-Sequencing
	Preparing Sequencing Machine
	Installing App-V Sequencer
	Configuring App-V Sequencer
	Adding Exclusion item
	Custom Default.sprj
	Creating Default.sprj
	Using Text Editor
	Using App-V Sequencer


	Sequencing
	Types of Sequencing
	MNT Sequencing or Q: Drive Sequencing
	Benefits
	Drawbacks

	VFS Sequencing
	Benefits
	Drawbacks


	Sequencing
	Configuration Wizard
	Installation Wizard
	Shortcut Wizard
	Sequence Cleanup


	Publishing and Testing
	Publishing Application
	Installing Microsoft App-V Management Console (MAMC)
	Prerequisites
	Installation
	Publishing


	Testing
	App-V Server


	Appendix
	Naming Convention
	Generic Guideline for Naming Convention

	Naming Convention in App-V
	Sequence Name
	OSD File Name



